
Lab 3: Wave Phenomena in the Ripple Tank

I. Before you come to lab...
A. Read the following chapters from the text (Giancoli):

1. Chapter 15, sections 1, 2, 4, 6, 7, 8, 10
2. Chapter 16, section 6
3. You may also find it helpful to look at Chapter 35, sections 1-3 (in volume 2). Although these sections deal with the wave nature of 

light, the results are more generally applicable to all types of waves.
B. Read through the entire lab, paying particular attention to the introduction and equipment list.
C. Answer the questions at the end of this writeup and be prepared to turn them in at the beginning of lab.

II. Introduction
A. Traveling waves

1. The wavelength λ of a wave is defined as the smallest linear distance after which the wave repeats itself. For a sinusoidal wave, it 
is also equal to the distance between consecutive crests or consecutive troughs at a given instant.

2. The period T of a wave is defined as the shortest time after which the wave repeats itself. For a sinusoidal wave it is also equal to 
the time interval between consecutive crests or consecutive troughs observed at a fixed point in space.

3. The frequency f is the reciprocal of the period. It can be thought of as the number of full wave cycles per second. The units of 
frequency are the Hertz (Hz). 1 Hz is equal to 1 inverse second.

4. The angular frequency ω is equal to 2π/T or 2π times f. ω is a useful quantity in mathematical descriptions of waves. The units of 
ω are radians per second. Similarly, the wave number k is equal to 2π/λ. The units of k are radians per meter.

5. For any traveling wave, the speed of propagation v is equal to the wavelength times the frequency:
v = λf
This makes intuitive sense: the wave travels a distance λ during each period T, so the speed is λ/T or λf.

B. Waves in two and three dimensions
1. In more than one dimension, even a single crest occurs at more than one place at a given time. The set of all the points 

comprising a wave crest is called the wavefront.
2. There are two important special cases of wavefronts: plane waves and spherical waves.

a. In a plane wave, the wavefront is a plane (in 3-D) or a line (in 2-D). In either case, the front is perpendicular to the direction of 
motion of the wave.

b. In a spherical wave, the wavefront is a sphere (in 3-D) or a circle (in 2-D). In this case, the wave motion does not have a well-
defined direction; it spreads outward from the front rather than in a fixed direction.

3. The reason that these two special cases are important is because of Huygens' principle, which states that as a wave propagates, 
each point on a wavefront acts as the source of a new spherical wave, called a wavelet. The propagating wavefront consists of 
the envelope of all of those wavelets (the shape which describes the outer edge of the wavelets).

4. Plane waves and spherical waves automatically maintain their shape as they propagate, due to Huygens' principle. This is 
illustrated by the following diagram:

a. For a plane wave, each point on the original wavefront A becomes the source of a new spherical wave (shown in red). A short 
time Δt later, the envelope of all those new waves is the wavefront B, which is also a plane because it is a fixed distance c Δt 
from A (here c is the wave's speed).

b. For a spherical wave, the envelope is also spherical. The wave propagates outwards in all directions from the original 
wavefront. Note that a wave emerging from a point source would propagate as a spherical wave

5. It is often helpful to think of rays instead of wavefronts (this is particularly true when dealing with plane waves). A ray is a line 
drawn in the direction of the motion, perpendicular to the wavefront.

C. Reflection
1. Reflection occurs when a wave is incident upon a barrier or boundary.
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drawn in the direction of the motion, perpendicular to the wavefront.
C. Reflection

1. Reflection occurs when a wave is incident upon a barrier or boundary.
2. The figure below shows wavefronts incident upon a plane barrier:

3. The dashed line indicates the direction perpendicular to the barrier and is called the normal line. The angle of incidence θi is 
measured between the incident ray and this normal line; likewise for the angle of reflection θr. Alternatively, you could measure 
the angle of incidence between the incident wavefront and the barrier itself, and similarly for the angle of reflection.

4. The law of reflection states that the angle of incidence is equal to the angle of reflection.
5. The above results are for a wave incident upon a plane barrier. If the barrier is not smooth, the law of reflection still holds, but the 

angle of incidence will be different at different places, and hence so will the angle of reflection:

D. Refraction
1. When a two- or three-dimensional wave is traveling in one medium, and it crosses a boundary into a medium where the wave 

speed is different, the wave changes direction. This phenomenon is known as refraction. An important example, which we will 
investigate in this lab, occurs when water waves move from a region of deep water (where the wave speed is high) to a region of 
shallow water (where the wave speed is low):

2. Refraction can be understood from Huygens' principle. The wavefronts at the boundary are divided: part of each front is fast-
moving and the other part is slow-moving. As they cross the boundary, the distance between wavefronts depends on how long 
that part of the wavefront has been in the slow medium, so the direction changes. The amount of bending depends on how 
different the wave speed is on the two sides of the boundary.

3. One important point to note, which is easy to see in the diagram above, is that the wavelength is different in the two regions. 
However, the frequency is the same. So the ratio of wavelengths on either side of the boundary is exactly equal to the ratio of 
wave speeds.
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4. The quantitative details of refraction are worked out in section 15-10 of Giancoli. For our purposes, it suffices to know the main 
result. We define the angle of incidence and the angle of refraction similarly to the way they were defined for reflection. In the 
diagram below (which is for light refracting at an air-glass interface, but the principle is the same), the angle of incidence is θ1 and 
the angle of refraction is θ2.

The law of refraction (also called Snell's Law) states that sin θ1/sin θ2 = v1/v2. Notice that the ray bends towards the normal (θ2 < 
θ1) if the speed is lower in region 2; it would bend away from the normal if the speed were higher in region 2. Expressed in terms 
of wavefront directions instead of ray directions, the wavefront bends closer to the direction of the boundary if the wave is moving 
into a slower region, and further from the direction of the boundary if it is moving into a faster region.

E. Interference
1. You have already seen interference of waves in one dimension, in our discussion of standing waves. The principle is exactly the 

same in more than one dimension: the resulting displacement due to two different waves incident upon the same place at the 
same time is the algebraic sum (or superposition) of the displacement due to each wave.

2. However, in two or three dimensions, very interesting spatial patterns can emerge. Consider the simplest case, where you have 
two waves generated by point sources located a distance d apart, each with the same frequency f, wavelength λ, and speed v = 
λf. We already know that a point source generates a spherical wave that propagates outwards from the point. When there are two 
point sources, a pattern such as the following is generated:

3. Qualitative features of interference
a. In general, the displacement at any given location is a complicated function of time. However, there exist special locations 

where there is always zero displacement, like point B in the figure above. These places are called nodes, just the same as 
nodes in standing waves. Nodes are places where there is always destructive interference.

b. There are also places like point A, where the displacement can be a maximum. These places are called antinodes. Antinodes 
are places of constructive interference.
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where there is always zero displacement, like point B in the figure above. These places are called nodes, just the same as 
nodes in standing waves. Nodes are places where there is always destructive interference.

b. There are also places like point A, where the displacement can be a maximum. These places are called antinodes. Antinodes 
are places of constructive interference.

c. One thing you might notice from the figure is that there appears to be an entire line of nodes that includes B, and stretches out 
from the center of the wave sources. This is a general feature of this type of interference pattern and is called a nodal line. 
Similarly there are antinodal lines such as the one passing through A. Very close to the sources, it gets more difficult to say 
what is happening, but the nodal/antinodal curves definitely seem to be straight lines far from the sources.

4. Quantitative analysis of interference
This section may make more sense to you after interference has been covered in lecture.
a. At each of the sources (call them S1 and S2), the displacement is just a sinusoidal function of time. We will assume that the two 

sources are in phase.
b. The nature of the interference at a given point (constructive or destructive) depends critically on the difference in path length 

from that point to the two sources:

c. Consider any point, say point A. The wave from S1 travels to A via the upper path whose length has been labeled r1(A), and 
the wave from S2 travels to A along the lower path labeled r2(A).
(1) If r1 = r2, then the interference is constructive, because that means that the two waves left S1 and S2 at the same time, 

when the sources were in phase. So they will still be in phase. In the diagram, the points for which r1 = r2 are on the x-axis, 
and we can see that it is indeed an antinodal line.

(2) If r1 ≠ r2 but they differ by an integer number of wavelengths, then the interference is still constructive. This is the case for 
point A. This means that the times when the two waves left S1 and S2 are not the same, but they are a whole number of 
periods apart, so they are in phase anyway.

(3) If r1 and r2 differ by a half-integer number of wavelengths, then the interference is completely destructive (as is the case 
for point B). This means that the waves are different in phase by π (or 3π, or 5π, etc.), so there is wholesale cancellation 
between the two waves. The net effect is zero displacement.

d. A detailed calculation (see section 35-3 of Giancoli) reveals why the nodes and antinodes form lines. The main result is that the 
path difference (r2-r1) is equal to d sin θ, where d is the distance between the two sources and θ is the angle with the positive 
x-axis, as indicated in the picture above. Thus:
(1) For constructive interference, d sin θ must be an integer multiple of λ. Expressed as a mathematical equation, this 

becomes
d sin θ = nλ
for any integer n. n=0 corresponds to the "central maximum," which is the x-axis in the figure.

(2) For destructive interference, we have
d sin θ = (n+½)λ
for any integer n.

(3) The two nodal lines on either side of the central maximum have the equation d sin θ = ±λ/2. Thus the angle between these 
two lines is Δθ = 2 sin-1(λ/2d). This is a result that you will use in the last part of the lab.

III. Materials
A. Ripple tank

The ripple tank is a shallow tank of water with a glass bottom used to visualize waves. Light from an overhead source passes 
through the water and is projected onto a screen. The patterns of waves (ripples) on the water's surface show up as shadows on the 
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A. Ripple tank
The ripple tank is a shallow tank of water with a glass bottom used to visualize waves. Light from an overhead source passes 
through the water and is projected onto a screen. The patterns of waves (ripples) on the water's surface show up as shadows on the 
screen.

B. Ripple tank paraphenalia
1. Plane wave dipper
2. Circular wave dippers
3. Big yellow plastic triangle
4. Aluminum "walls"

C. iSight camera
You'll use this to capture images and videos from the ripple tank screen and analyze them in Logger Pro.

IV. Procedure
A. Before you begin...

1. Take a picture of yourselves using Photo Booth. Drag the photo into the space below:

 
2. Tell us your names!

B. Wavelength, frequency and velocity
1. Setup

a. Set up your ripple tank with the plane wave dipper.
b. Make sure the iSight camera is on (if the shutter is closed, twist the end of it to open it). The green light on top of the camera 

should go on.
c. Open the Logger Pro file Lab3.cmbl.
d. From the Insert menu, select Video Capture. You should be prompted to select a camera; choose IIDC FireWire Video. If it 

then asks you which resolution you want, select 800x600.
e. A video capture window will open. Within it, click the Options button. Set the following options:

(1) Video Capture Only (as opposed to Video Capture Synchronized with Data Collection).
(2) Capture duration: 10 seconds
(3) Do not check the box for Time Lapse capture.
(4) Capture Filename Starts With: Wavelength
(5) Click OK.

f. Position the iSight camera so that the ripple tank screen approximately fills the field of view. Try to get as head-on a view as you 
can.

g. You are now ready to begin capturing video of the waves in the ripple tank. If you have trouble with any of these steps, ask 
your TF for help.

2. Turn on the ripple tank by turning the Frequency knob to the position marked "C." The plane wave dipper will start to oscillate up 
and down, sending ripples across the tank.

3. In the Video Capture window, click Start Capture. Wait for 10 seconds. The video will appear in Logger Pro behind the active 
window. Close the Video Capture window.

4. You should see something approximately like the following:
a.

5. Video analysis of captured movie
a. Video analysis basics

(1)
First, enable video analysis by clicking the  button in the lower-right corner of the movie. A graph will appear in the 
background, and a toolbar will appear on the right edge of the movie.

(2) Here is an explanation of the buttons in the video analysis toolbar:
(a)
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(a)

(b)

(c)

(d)

(e)

(f)
 Set Active point: Adds new x,y columns and becomes the current/active point. This active point set will have a 

horizontal line on either side of it. There is a limit of 3 point sets.
You will not need to use the Set Active Point button in this part, but you will use it later.

b. Determination of wavelength
(1) First, set the origin and line up the axes so that the y-axis is parallel to the wavefronts. It doesn't matter which point you 

choose for the origin, but it is easiest to orient the axes correctly if the point is on a wavefront--i.e. a boundary line between 
light and dark regions.

(2) Next, set the scale. To assist you in this, a label has been stuck to the underside of each ripple tank and its shadow should 
be visible in your movie. The label is 5.0 cm long.

(3) Finally, use the Photo Distance button to measure the wavelength.
(a) The alternating dark and light bands in the picture are waves; one wavelength is the distance between adjacent bands. 

More precisely, it is the distance between the left edge of one dark band, and the left edge of the next dark band.
(b) Using the Photo Distance button, click and drag across as many whole wavelengths as will fit into the window at once. 

Be sure to click and drag in a direction perpendicular to the wavefronts.
(c) The Photo Distance feature will tell you the length of the line you have drawn. Divide that length by the number of 

wavelengths it represents to get the length of a single wave. (This is more accurate than just measuring one 
wavelength.)

(d) Record your result (in cm) here:
λ = 

(e) Paste a screenshot of your movie window below:
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(e) Paste a screenshot of your movie window below:

 
c. Determination of frequency

(1) Use the video controls to step through the movie. The controls are:

Play, Stop, Rewind to beginning, Back one frame, Forward one frame
Warning: the buttons are pretty finicky. If the mouse cursor turns into a hand, Logger Pro thinks you are trying to "grab" the 
bottom edge of the window so you can drag it to another location. The same goes for the left edge of the Play button. To 
get around this nuisance, try to click on the upper half of the button.

(2) The upper right corner of the window displays the time (in seconds) of the current frame. You should notice that it 
increases by about 0.067s per frame. (There are 15 captured frames per second.) The very first frame might be somewhat 
longer than this, so don't use it.

(3) As you step through the movie, count how many wavefronts pass by a fixed location in the window (the origin you chose in 
the last part makes for a convenient fixed location.)

(4) Note your starting time, and then determine the time elapsed before 50 waves pass your fixed point. This number is 50 
times the period of the wave.

(5) Finally, calculate the frequency by taking the reciprocal of the period (or 50 divided by the total time elapsed).
(6) Record your result (in Hz) here:

f = 
d. Determination of wave velocity

(1) For this part, you will need to use the Add Point feature. When the Add Point button is selected, clicking in the picture does 
two things:

(a) it records the x- and y-coordinates (in cm) of the point you selected; and
(b) it automatically advances to the next frame.

(2) The coordinates of the points you select will automatically appear in the graph in the background. You will see two sets of 
points; one is x vs t, the other is y vs t.

(3) Use this feature to follow a wavefront frame-by-frame. Just keep clicking on the position of the wavefront in each frame. If 
you make a mistake, don't worry about it--just keep going and you can correct it later.

(4) You might find it difficult to tell exactly which wavefront went where in the time between frames. Just remember that the 
wave is moving to the right, and under these conditions the wave should be moving slowly enough that it doesn't travel 
more than one wavelength per frame.

(5)
When you are finished, click on the graph of x and y vs time and perform a linear fit by clicking the  button. When 
asked to pick a column, choose X (if you aligned your axes correctly, the Y data set should be very uninteresting).

(6) Logger Pro will calculate the best-fit line to the series of points and tell you the slope. If there are one or more data points at 
the ends that you don't want in your data set, click and drag the little brackets at the endpoints of the fitting region to 
exclude them. If there is a point in the middle that you want to take out, click and drag over a horizontal region in the graph 
that includes only that point, and then press Apple-minus (or Strike Through Data Points from the Edit menu) and the point 
will disappear.

(7) The slope of the graph should tell you the x-velocity of the wavefront, which is the same as the velocity of the water waves. 
Record that value here (in cm/s):
v = 

(8) Paste a screenshot of your graph here:

 
e. Compare the three quantities you measured in this part. Do they obey the equation that you expect to govern their 

relationship? If not, how big is the discrepancy?
 

f. Save your Logger Pro file (Apple-S) before moving on to the next part. Save this file too (Apple-S in NoteBook).
C. Reflection

1. Setup
a. Turn to page 2 of the Logger Pro file.
b. Insert a metal "wall" into your ripple tank at an angle to the plane wave dipper, as shown in the picture below:
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Have the upright part of the wall (the part that actually sticks up out of the water) on the side nearest the waves (in the above 
picture, the upper left edge as opposed to the lower right).

c. Turn off the ripple tank by turning the Frequency knob down to "A."
d. Insert → Video Capture. Click the Options button. Keep all of the same settings as previously, except this time:

Capture Filename Starts With: Reflection
Click OK.

2. Start the video capture. While the video is recording, gently tap the motor box of the ripple tank. You should see just one or a few 
waves (rather than a repeating source of them) from the plane wave dipper travel to the right and reflect off the wall.

3. When the movie appears in the background, close the Video Capture window.
4. Use the Video Analysis tools to measure the velocity of the wave both before and after it reflects from the wall.

a. Enable Video Analysis.
b. Set the scale, just like you did last time.
c. This time. set the origin to be a point on the aluminum wall, and turn the axes so that the x-axis is along the wall itself. This will 

make it much more convenient later on to compute the angles of incidence and reflection.
(1) The axes should look like this:

d. Advance the movie until you see the wavefronts generated when you tapped the motor box. Watch what happens as the 
wavefront approaches the wall. It is reflected at an angle, but you may also see a few ripples that are parallel to the surface of 
the wall. It may help to watch the movie several times frame by frame.

e. Now rewind back to the time when the wave began and click on Add Point. Using this feature, track the wavefront until it hits 
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wavefront approaches the wall. It is reflected at an angle, but you may also see a few ripples that are parallel to the surface of 
the wall. It may help to watch the movie several times frame by frame.

e. Now rewind back to the time when the wave began and click on Add Point. Using this feature, track the wavefront until it hits 
the wall. Try as hard as you can to place your points in a line perpendicular to the wavefront (and therefore parallel to the 
direction of motion).

f. After the wave hits the wall, it reflects. Use a separate series of data points to track the motion of the reflected wave. Do this by 
clicking on Set Active Point and choosing Add Point Series. Now when you click it will record the positions in a different color 
and record it as "X2" and "Y2." You can also use the Set Active Point button to toggle between the two series.

g. It is not essential that you start tracking the reflected wave from the same point that your initial tracking hit the wall, but it might 
make it conceptually easier for you--that way, your two trails of points represent an "incident ray" and a "reflected ray."

h. Click on the graph and you should see four sets of points: x and y of the incident ray, and x and y of the reflected ray, all 
versus time. Do a linear fit for all four (the reflected ray data is called "X2" and "Y2") to find the velocity components in the x- 
and y-directions.

i. Record your velocity data here (in cm/s):
v_xi = 
v_yi = 
v_xr = 
v_yr = 

j. Paste the graph of the four lines here:

 
5. Compare your results to the theoretical predictions:

a. Is the speed of the incident wave equal to the speed of the reflected wave?
 

b. Calculate the angles of incidence and reflection (in degrees):
θ_i = 
θ_r = 

c. Does the law of reflection hold?
 

6. Save your Logger Pro file, and this file, before moving on.
D. Refraction

1. Setup
a. Turn to page 3 of the Logger Pro file.
b. Remove the "wall" from your ripple tank and put in the big yellow triangle. The water level should be deep enough to cover the 

triangle. Turn the triangle so that it is "pointing" at the dipper and one edge is parallel to the direction of motion of the waves, 
as shown below. Hold onto the triangle until it stops slipping around.
(1)

c. Turn the ripple tank motor back on by setting the frequency knob back to "C."
d. Insert → Video Capture. Click the Options button. Keep all of the same settings as previously, except this time:

Capture Filename Starts With: Refraction
Click OK.

2. Start the video capture. Wait for 10 seconds until the movie appears. Close the Video Capture window.
3. Notice what happens when the waves reach the edge of the yellow triangle. They appear to bend and move into the triangle at a 

different angle. This is because of refraction.
a. The edge of the triangle is a boundary between two regions of different wave speed--the waves move slower in the yellow 

region.
b. This is because the depth of water in the yellow region is lower. You don't have to understand why the wave speed changes 
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a. The edge of the triangle is a boundary between two regions of different wave speed--the waves move slower in the yellow 
region.

b. This is because the depth of water in the yellow region is lower. You don't have to understand why the wave speed changes 
with depth--the speed of water waves is a very complicated subject, far beyond the scope of this course.

4. As you did in the previous part, use the Video Analysis tools to track a wavefront as it moves towards the boundary, and then use 
a different point series (using the Set Active Point button) to track a refracted wavefront in the yellow region. Again, you will want 
to orient your axes so that the x-axis coincides with the boundary between the two regions.
a. Paste a screenshot of your movie with all the trail points here:

 
b. Determine the x- and y-components of the velocity for both the incident and refracted wave. Record the values (in cm/s) here:

v_xi = 
v_yi = 
v_xr = 
v_yr = 

c. Paste your graph here:

 
d. Calculate the wave speed (in cm/s) in the two regions:

v_i = 
v_r = 

e. Calculate the angles of incidence and refraction (in degrees):
θ_i = 
θ_r = 

f. Does the law of refraction (Snell's Law) hold?
 

5. Save your Logger Pro file, and this file, before moving on.
E. Interference

1. Setup
a. Turn to page 4 of the Logger Pro file.
b. Remove the big yellow triangle. Turn off the ripple tank motor.
c. Remove the entire motor assembly from the water (pick up the whole stand and move it). Remove the plane wave dipper and 

replace it with two small circular dippers. Put the dippers back into the water. Turn them so that they are a few cm apart.
d. Turn the ripple tank motor back on by setting the frequency knob back to "C."
e. If you cannot see the two sources on the screen, push the stand holding the motor box so that the dippers are moved further 

out into the water.
f. Insert → Video Capture. However, this time you will not actually be doing any video captures! Instead you will be taking still 

photos.
2. Observe what happens to the wave pattern as you increase the frequency.

a. The wavelength gets shorter, which must be true because the speed of waves is constant (it only depends on the water depth).
b. If you look a few wavelengths away from the sources, you should begin to see "lines" where there is never any wave 

displacement. These are nodal lines. As the frequency goes up, the angle between these lines decreases.
c. The horizontal line passing through the midpoint of the two sources should be an antinodal line at any frequency. You will 

attempt to measure the angle between the two nodal lines on either side of this central antinode at different frequencies.
3. Increase the frequency to E and click the Take Photo button. A still photo will appear in the background.
4. Turn to page 5 of the Logger Pro file and take another photo, this time with the frequency set to G.
5. Turn to page 6 of the Logger Pro file and take one last photo, this time with the frequency set to I.
6. Save your Logger Pro file.
7. Close the Video Capture window and return to page 4 where you took the E photo. You will use the Photo Analysis tools to make 

some measurements based on this photo.
a. Right-click on the photo and select Photo Options. Select Standard Analysis and click OK. You will see the now-familiar toolbar 

appear on the right edge of the photo.
b. The buttons work pretty much exactly the same way as they do for video analysis, except that there is only one frame, and 

hence no time dependence.
c. Use the 5.0 cm label to set the scale.
d. Use the Photo Distance button to measure the wavelength as accurately as you can. Record that value (in cm) here:
λ = 

e. Measure the distance between the centers of the two dippers. Record that value (in cm) here:
d = 
If you can't tell what d is from your photograph, try taking another photograph with the motor turned off. 

f. Now click Add Point and try to trace out one of the nodal lines, clicking once per wavelength on where the wavefront would be if 
it continued through the nodal line. Instead of seeing the x- and y-coordinates of each point versus time, you'll see a graph of 
just y versus x.

g. Hopefully the points form a straight line.
(1) What is the slope of this line?

m1 = 
(2) What angle (in degrees) does this line make with the positive x-axis?

θ1 = 
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m1 = 
(2) What angle (in degrees) does this line make with the positive x-axis?

θ1 = 
h. Now add another series of points (using the Set Active Point button) and repeat the process for the other nodal line.

(1) m2 = 
(2) θ2 = 

i. What is the angle formed between the two nodal lines?
Δθ = 

j. Are your results consistent with the equation for interference?
 

k. Paste a screenshot of your photo here:

 
8. Move to page 5 and repeat this process for the higher frequency ("G") in this photo. You don't need to measure the distance 

again, since it's the same.
a. λ = 
b. m1 = 
c. θ1 = 
d. m2 = 
e. θ2 = 
f. Δθ = 
g. Are your results consistent with the equation for interference?

 
h. Paste a screenshot of your photo here:

 
9. Repeat for the highest frequency ("I") on page 6.

a. λ = 
b. m1 = 
c. θ1 = 
d. m2 = 
e. θ2 = 
f. Δθ = 
g. Are your results consistent with the equation for interference?

 
h. Paste a screenshot of your photo here:

 
V. Conclusion

A. You've reached the end of the lab. Congratulations!
B. Save your work in this file and in Logger Pro.
C. Submit the electronic copy of your lab report as you did for Lab 2. The instructions for doing so are on a laminated sheet by each 

computer. They are slightly different this time because you will want to save your images in addition to the Logger Pro file.
VI. Pre-lab assignment.

Answer the following questions on a separate sheet of paper before coming to lab. Remember to write your name and lab time on the 
sheet.
A. Consider a wave front incident upon a plane boundary. The velocity of the wave is in the direction of the incident "ray" as shown 

below:

Take the x-axis to be along the boundary and the y-axis along the normal, as shown. In terms of the velocity components (v1x, v1y) of 
the incident ray and (v2x, v2y) of the reflected ray, calculate the following. Be careful about signs!
1.

The angle of incidence θ1
2.

The angle of reflection θ2
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1.
The angle of incidence θ1

2.
The angle of reflection θ2

3.
If the law of reflection holds, calculate v2x and v2y in terms of v1x and v1y.

B.
Now consider the incident and refracted rays in the diagram below. 

In terms of the velocity components (v1x, v1y) of the incident ray and (v2x, v2y) of the refracted ray, calculate the following. Again, 
watch out for signs.
1. The speed of the incident wave
2. The angle of incidence θ1
3.

The speed of the refracted wave
4. The angle of refraction θ2
5.

State the law of refraction (Snell's Law) terms of the four velocity components.
C. Consider the interference setup below, consisting of two point sources a distance d apart:

Suppose you are told that the antinodal line through point A has the equation y=mx and you are given the value of m. Calculate the 
following, in terms of m and d:
1. the angle θ
2. the wavelength λ
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